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sarahwhichello
Sticky Note
(Take "You" as "You all")

Overall, this is a wonderfully done tutorial. You provide clear and ample instructions, useful graphics, and show an impressive attention to detail. I like that your tutorial has a clear introduction and outlines exactly what the user will be doing throughout the session. After reading through the tutorial twice I noticed some minor inconsistencies. Some of my suggestions are based on personal preference so keep that in mind. Because you worked so hard I did not find many substantial issues. 

Here are my suggestions in order of relevance (most relevant first, least relevant last): 

1. I noticed that you have many sections in this tutorial. While I can see the logic behind splitting up the tasks, there are instances where the sections seem overly short. Perhaps consider combining some of the shorter sections to improve the flow of the document. As is, some of the sections feel quite choppy. 
2. Because you so often transition from section to section, users might benefit from more detailed transition blurbs. These blurbs might clearly state that the user will be transitioning to a new task. 
3. There are a few areas where graphics and color are inconsistent. For example, some of your numbers are outlined with red diamonds and some are not. Also, the section conclusion blurbs begin in red and end in blue. 
4. There are also some word choice/ text formatting inconsistencies. See my comments on page 6 and 8 for suggestions about quotation mark usage and bolding. Also see my comments on page 12 for OK VS Okay. 
5. There are some areas where graphics (arrows, borders) are not ideally placed. I have noted those areas in the comments. An example of this is the arrow on page 3 that covers a portion of the word "Letter." 
6.Perhaps create a final page with the "congrats" blurb and perhaps a recap of the tutorial as a whole.    
7. A very personal preference opinion would be that you select a font and color for your heading that better matches the other fonts and the InDesign color scheme. 
8. Some of your images appear blurry on my display. This may be an issue on my end but if not I would consider using screen grabs with a bit more clarity. 

Again, great work!  
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InDesign: Text, Styles, and Page Numbering

This tutorial is a step-by-step guide to a few basic tasks in Adobe™ InDesign® 
2021. The audience is novice users who are technical and professional writing 
students at UNC Charlotte. 

The tutorial provides instructions on how to: 
1) set up, name, and save an InDesign document; 
2) create text boxes and fill them with placeholder text; 
3) create a heading style in a specific typographic style; 
4) apply the new heading style to headings in the document; 
5) create a paragraph style; 
6) apply the paragraph style to the text in a text box; and 
7) use the parent page function to apply page numbers and a running header.

 The tutorial is simplified and customized to get students in UNC Charlotte 
courses quickly into using InDesign for their coursework. The students in these 
courses may have a wide range of experience with Adobe InDesign from no 
previous experience to advanced professional experience. These students are 
preparing for professional positions as technical writers, graphic designers, 
usability experts, and other related careers.

The tutorial is intended to be open next to a blank InDesign document and 
followed step-by-step as the student works through the tasks. By the end of the 
tutorial, students will be able to repeat the tasks independently and build their 
expertise with other tutorials that focus on other basic InDesign tasks.

Introduction...

sarahwhichello
Sticky Note
The cursive does not seem like the best match with the other fonts. 

sarahwhichello
Sticky Note
I know you designed this for a PC. Maybe say that in the intro. 

sarahwhichello
Sticky Note
Do you need "page" or could you just use numbers? 



Page 3

InDesign: Text, Styles, and Page Numbering

 
Download and install Adobe InDesign on your computer.

Double-click the   desktop icon on your computer desktop or select

 Creative Cloud           from your list of applications on your Windows  menu 
and open the latest version of InDesign from the list. Wait while the applica-
tion loads.

Double-click on “Letter.”

Create an InDesign Document...

2

3

4 A blank letter-sized document 		
will open.

1

sarahwhichello
Sticky Note
The arrow on this page slightly covers the word "Letter" 
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Click on the File menu and select “Save 
As.”

5

Click on the folder where you wish to save your document. (“Desktop”).6

Type a Name for the file in the “File name:” field. Click the “Save” button.7
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 Click on the white T on the vertical Toolbar.

Create a Textbox with Filler Text... 
1

2 Click in the document, hold 
down the mouse button while 
you drag down and to the right 
in the blank document to create 
a Textbox of any size.

 Right click inside the Textbox to bring up the fly out menu. 
 Left click on “Fill with Placeholder Text.” 
 The Textbox will be filled with Lorem Ipsum filler text.

textbox

3

sarahwhichello
Sticky Note
This outline box seems to be slightly off. It may be unnecessary. You also do not use this outline throughout. 

sarahwhichello
Sticky Note
Perhaps split this sentence into two. It is a lot to parse as one sentence. 

sarahwhichello
Sticky Note
This arrow is layered over text. 
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Creating a New HeadingStyle...

1. Create a new blank text box at the 			
	 top of the page (following steps 1 and 2 		
	 under “Create a Textbox above”). In the 	
	 new text box, type in the word “Heading” 	
	 and center it, using the center button 
	 found in Properties menu under 			 
	 “Paragraph.” 

2. Make sure you have the Character Styles 	
	 panel selected in the Properties panel. 		
	 It is located next to the Paragraph Styles 	
	 panel.

You will now change the font size 
of the “Heading” text.  

1. Highlight “Heading.” Next, look at 
the Character section in the Properties 
panel. The Character section is the 
second section, underneath the 
Appearance section.

2. You will see an icon that looks like a 
little T and a big T. This is the icon for 
font size. Use the drop-down arrow to 
change the font size to 36pt.

sarahwhichello
Sticky Note
I noticed that in some areas you place quotes around key words and in some areas they are left bare. 

sarahwhichello
Sticky Note
There is nothing wrong here, but could you make the transition more visually pleasing/ obvious? 

sarahwhichello
Sticky Note
You lack clear graphics for this step. 

sarahwhichello
Sticky Note
This number formatting is different than previous pages. 
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Next, you will change the font 
style

1. While the text is highlighted, you 
will click the drop-down arrow of 
the first Character search bar.This 
is the font search bar. The current 
font style is Minion Pro. 

2. After clicking the drop-down 
arrow, you will use the scroll bar 
to find the font Bell MT.  Once 
you have found this font, Select it.

 

sarahwhichello
Sticky Note
Do you need this "you will" here? 

sarahwhichello
Sticky Note
Should be a lower case "s"

sarahwhichello
Sticky Note
You do not have a graphic for this.
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Now that you have changed the font style, you will now change the 
font to bold/italics

1. Underneath the first search bar, 
you will see another search bar that 
shows Regular.

2. Click the down arrow for the bold 
and italics selections and choose the 
desired one. In the example below, 
Bold was selected for the Bell MT 
font. 

This is the text now in a new font style and in bold. 

sarahwhichello
Sticky Note
Italic 

sarahwhichello
Sticky Note
Shows or "reads"? 

sarahwhichello
Sticky Note
Maybe be consistent about bolding the word bold when you reference it. 

sarahwhichello
Sticky Note
Can you simplify this sentence? 
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The final step of this task will be to change the color. Remember to 
keep the text highlighted.

 
1. Look at the Appearance section 

above the Character Section. This 
is where you can change the font 
color.

 
2. You will notice two white squares 

that have a red line running 
diagonally through each one. One 
will be titled Fill and one will be 
titled Stroke. In order to add 
color to the text, you will use the 
Fill option. Click the square next 
to Fill. 

3. You will now see a smaller 		
window that shows a variety of 
colors to choose from for your text. 
For this practice, select the red that 
has the C=15 M=100 Y=100… 
properties. This will change the 
color of your text. 

Good work! You have now successfully changed the font size, style, 
bold/italics, and color. Now that the changes have been made, you 

can name your new typographic style.

sarahwhichello
Sticky Note
I like that you remind the reader here. 

sarahwhichello
Sticky Note
Italic?

sarahwhichello
Sticky Note
Could 1 and 2 be combined? Step one is not actually directing the user to do anything but visually locate the icon. 
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Naming New Typographic Style...

Make sure that your “Heading” text is highlighted. You will also want 
to double check that you are still in the Character Styles tab in the 

Properties menu on the right. This is particularly important in naming 
your new style. 

1. In the Character Styles panel, you will see an A. icon like this.         Click the A. 
icon. Once you click the icon, a list of options will appear. Click the first option 
that says Character Styles.

2. A new, smaller window will appear. Look down at the bottom panel of this new 

window. You will see a small icon that is a square with a plus sign.   This is 
the Create New Styles icon. Click it. 

sarahwhichello
Sticky Note
Can you provide more of an introduction in this half of the tutorial? 

sarahwhichello
Sticky Note
I like the use of in-text icons here. 

sarahwhichello
Sticky Note
Sometimes you say "click on it" sometimes you say "click it." 

sarahwhichello
Sticky Note
This is a large space that you do not have on the other beginning section pages.
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3. A new name will show up in the list, Character Style 1. Double-click this 		
	 title and a new window will open. 

4. In the new window, you will see a bar at the top titled Style Name. Replace 		
	 “Character Style 1” with a new name for your font type.  

WARNING: Before you rename, check that the properties you 
applied to the new font type have remained the same. Otherwise, all 

of your hard work wont be saved!

5. In order to check this, you will look at the left panel and find the 			 
names Basic Character Formats and Character Color. You will click 		
each option on the menu, starting with “Basic Character Formats.” 

6. When you click each option, you will see the unique features of 			 
your font type: size, font style, and bold/italics. 

sarahwhichello
Sticky Note
Nice!

sarahwhichello
Sticky Note
Maybe use : rather than , 

sarahwhichello
Sticky Note
Are the "You will's" needed? If you cut them it may read smoother. 
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 7. If everything is correct, click okay. Then, rename your new font type in the 		
Style Name bar. In this example, the new style is named with the default 	
Character Styles 1.  

8. Once you rename your new typographic style, click OK to save and then 
close the Character Styles window. Notice that your new font type is visible 
in the Properties panel under the Character Styles panel. 

Congratulations! You have now learned how to make a new 
typographic style and name it! Now you can move on to the next 

step!

sarahwhichello
Sticky Note
Is it "okay" or OK on the screen? I think it is OK 

sarahwhichello
Sticky Note
This is a bit blurry on my computer. 

sarahwhichello
Sticky Note
This was red in the last section. 
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Creating a Paragraph Style

1.	 Select and highlight the text. Open the Paragraph Styles panel on the right 
side and choose New Paragraph Style.  
 
 
 
 
 
 
 
 
 
 
 
 
 

2.	 The New Paragraph Style dialog box will appear with a generic name 
highlighted. Give your new style a new name and press enter or click ok. 

3.	  

2. The New Paragraph Style dialog box will appear with a generic name 			
	 highlighted. Give your new style a new name and press enter or click ok.

sarahwhichello
Sticky Note
Can you provide a more nuanced transition by including a blurb? 

sarahwhichello
Sticky Note
This is blurry on my computer. 

sarahwhichello
Sticky Note
Dialogue 

sarahwhichello
Sticky Note
ok or OK
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1.	Apply the style to any paragraph by positioning your text cursor within it or 
highlighting the text, and then clicking on the name of the style you saved in the 
Paragraph Styles panel.

Applying a Paragraph Style

sarahwhichello
Sticky Note
You have a lot of transitions/sections. Do you think it is necessary to split them all up in this way? 

sarahwhichello
Sticky Note
Can you spilt this into two sentences, it is a lot to parse. 

sarahwhichello
Sticky Note
This is a bit blurry. 
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With the A-Parent still highlighted, create a textbox large enough to hold 	
	 the longest page number and any text you want to appear with it. Position 	
	 the textbox where you want the page number to appear, normally in the 	
	 lower right margin of the document.

In the page number textbox, add any text that will come before or after the 	
	 page number (such as “Page ”) and format it using the Paragraph Style you 	
	 set up previously.

Position the insertion point where you want the page number to appear, 	
	 and from the Type drop-down menu select Insert Special Character > 	

Create a Parent Page...

A Parent (or Master) Page is a nonprinting page that serves as 
a template that can be applied to some or all of the pages in your 

document. Parent pages contain text and graphic elements like page 
numbers, headers, footers, etc. that you want on all or most pages. 
You can have as many parent pages as you want in a document and 

apply them to individual or groups of pages. 

On the upper right side of 
the InDesign document 
screen, 	click on the Pages panel. If 
the Pages panel is not showing, go 
to the Window drop-down menu 
and click on Pages to reveal it.

Double-click on A-Parent in the 
Pages panel to display the Parent 
Page.

1

1

2

2

Add Automatic Page Numbers...

3

sarahwhichello
Sticky Note
This is helpful! 

sarahwhichello
Sticky Note
You do not use consistent numbering. Here, the numbers are outlined with a red diamond, in other sections they are bare. 

sarahwhichello
Sticky Note
You use the formal InDesign name at the beginning of the tutorial but the informal one here. 

sarahwhichello
Sticky Note
This is difficult to see on a white background. 
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A running head is a heading printed at the top 
of each page of a book or chapter.

sarahwhichello
Sticky Note
This is very large and somewhat distracting, especially because it takes up an entire page. Is there any way to make it more compact and closer to step 3?  



Page 17

InDesign: Text, Styles, and Page Numbering

Right-click on a page to which 	
you want to apply the Parent 
Page in the Pages panel on the 
right.

Select Apply Parent to Pages. 	
You can apply the Parent Page 
to any or all pages.

1

2

Apply the Parent to your Pages...

With the A-Parent still highlighted, create a textbox large enough to hold 	
	 all the text of the running head in the location you want it, usually above the 	
	 frame of the document in the margin and aligned right. 

Type the text you want to appear at the top of every page. Format it using 	
	 the Paragraph Style you set up previously. 

2

1

Add a Running Head...

Congratulations! You have now learned how to add page numbers, 
a running head, and a parent to your InDesign document! You have 

successfully completed this tutorial!

sarahwhichello
Sticky Note
Should this perhaps be on its own page at the end? 

sarahwhichello
Sticky Note
This is very clear!




